Sandip Rai

Design of a Single Family House Using BIM Software
Modelling on ArchiCAD & Tekla Structures

Helsinki Metropolia University of Applied Sciences
Bachelor of Engineering
Civil Engineering
Bachelor’s Thesis
November 2016
The main objective of this Bachelor’s thesis was to create a model of a single family house using different Building Information Modelling (BIM) software. This thesis also aimed to provide the user with a manual for designing concrete structures using ArchiCAD and Tekla Structures. Each and every process of using the software has been clearly explained in this thesis.

The theoretical part of the thesis was collected from various articles and websites. It includes information and history about ArchiCAD and Tekla Structures. In addition to this, the advantages of using BIM software for Architects and Structural Engineers have also been presented in this thesis.

The practical part of the thesis involves the use of BIM software. The example of BIM software that was used throughout the thesis is Graphisoft ArchiCAD and Tekla Structures. The thesis explains the methodologies of creating 3D architectural design from 2D drawings in ArchiCAD, as well as 3D structural design in Tekla Structures from ArchiCAD IFC model. The solution for linking ArchiCAD model to Tekla software is also explained in the thesis.

Significant work of this project was based on the use of BIM software. The information and data for the thesis were collected from a single family house project which is located in Hyvinkää, Finland. As a result of this project, both Architectural and structural model of the single family house was created. Overall, this thesis can be beneficial to all the students and enthusiasts who are in the field of architectural and structural engineering. This thesis can serve as a guide to the users of ArchiCAD and Tekla structures. For structural analysis, further study should be conducted.
| Keywords                      | BIM, Design, Architecture, Structural Engineering, Modelling, ArchiCAD, Tekla Structures, Reinforcement, Connection |
FOREWORD

Firstly, I would like to thank Helsinki Metropolia University of Applied Sciences for accepting me into their degree program and the department of Civil Engineering for passing their knowledge and life time experiences and HÄME University of Applied Sciences for allowing me to work my final thesis at HAMK UAS.

Secondly, I owe my deepest gratitude to my supervisor, Tomi Karppinen who helped me while doing my final thesis at HAMK. I am heartily thankful to him for his encouragement, guidance and support from the initial to the final phase of thesis writing. Working with him together in the process of doing my final year thesis was a great opportunity for me to learn many new things.

I am also pleased to thank the Head of degree program of Metropolia UAS, Jorma Säteri for supporting me in this thesis. His advice and suggestions have always been useful during my writing.

Special thanks go to all my friends for their support and encouragement during the writing of this thesis. Their support and encouragement have been very important for me.

Finally, but first in my heart, my parents and all my family members in Nepal are due my sincere gratitude for their continued love and support throughout my studies.

Sandip Rai
24 Nov. 2016
Contents

1 Introduction 1

2 Building Information Modelling 2
  2.1 BIM for Architects 4
  2.2 BIM for Structural Engineers 5

3 BIM Software 5
  3.1 ArchiCAD 5
    3.1.1 History of ArchiCAD 5
    3.1.2 General Information on ArchiCAD 6
  3.2 Tekla Software 7
    3.2.1 History of Tekla 7
    3.2.2 General Information on Tekla 7

4 Project Description 8
  4.1 Building Information 8
  4.2 Building Plans and Drawings 10

5 Building Models 11
  5.1 Architectural Modelling 11
    5.1.1 ArchiCAD Basic 11
    5.1.1.1 Project Settings and ArchiCAD Interface 11
    5.1.1.2 Setting with Grids and Stories 13
    5.1.1.3 Importing Drawings in ArchiCAD 14
    5.1.1.4 Layer Settings in ArchiCAD 15
    5.1.1.5 Settings of the Building Materials 15
    5.1.2 Creating Architectural Model in ArchiCAD 18
    5.1.2.1 Foundation 18
    5.1.2.2 Walls 18
    5.1.2.3 Slabs 19
    5.1.2.4 Beams and Columns 20
    5.1.2.5 Roofs 22
    5.1.2.6 Staircase 22
5.1.2.7 Doors and Windows 23
5.1.2.8 Other Objects 24

5.1.3 Creating Drawings in ArchiCAD 25
5.1.4 Linking ArchiCAD Model with Tekla Structures 26

5.2 Structural Modelling 26
5.2.1 Tekla Basic 26
5.2.1.1 Tekla Set up & Interface 26
5.2.1.2 Setting with Grids in X, Y and Z Co-ordinates 28
5.2.1.3 Importing IFC Model in Tekla 28

5.2.2 Creating Structural Model in Tekla Structures 29
5.2.2.1 Foundation 29
5.2.2.2 Walls 29
5.2.2.3 Door and Window Openings 30
5.2.2.4 Slabs 31
5.2.2.5 Beams and Columns 32

5.3 Reinforcement Design 33
5.3.1 Beam and Column Reinforcement 33
5.3.2 Wall Reinforcement 34
5.3.3 Slab Reinforcement 34
5.3.4 Footing Reinforcement 35

5.4 Connection Design 36
5.4.1 Wall Connection 36
5.4.2 Beam and Column Connection 37
5.4.3 footing and Column Connection 38

5.5 Creating Drawings in Tekla Structures 38

6 Conclusion 40

7 References 41

Appendices
Appendix 1. Reference drawing
Appendix 2. ArchiCAD
Appendix 3. Tekla structures
<table>
<thead>
<tr>
<th>Abbreviations</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AEC</td>
<td>Architecture, Engineering and Construction</td>
</tr>
<tr>
<td>A &amp; D</td>
<td>Analysis and Design</td>
</tr>
<tr>
<td>API</td>
<td>Application Program Interface</td>
</tr>
<tr>
<td>BIM</td>
<td>Building Information Modelling</td>
</tr>
<tr>
<td>GDL</td>
<td>Geometric Description Language</td>
</tr>
<tr>
<td>IFC</td>
<td>Industry Foundation Class</td>
</tr>
<tr>
<td>STAAD</td>
<td>Structural Analysis and Design Computer Program</td>
</tr>
<tr>
<td>2D</td>
<td>Two - Dimensional</td>
</tr>
<tr>
<td>3D</td>
<td>Three - Dimensional</td>
</tr>
<tr>
<td>4D</td>
<td>Four - Dimensional</td>
</tr>
</tbody>
</table>
1 Introduction

Today, the use of new tools and software is one of the most recognized design methodologies in the field of building industry. Engineers are always looking for new methods to develop and keep the pace on today’s business resulting in high productivity, coordination and problem solving. (1) Building information modelling (BIM) can help with all these aspects. BIM is an intelligent 3D model-based process that helps Architecture, Construction and Engineering professionals to plan, design, construct and manage the buildings and infrastructure. (2) BIM helps to prepare a reliable digital representation of the building design for decision-making, high-quality construction documents, project performance and cost estimation. (3) One of the examples of the BIM is the use of a computer program, which can communicate with each other either by application programming interface (API) or by compatible file formats. The main aim of the thesis was to create the model of a single family house using different BIM software. In addition, this report also aims to serve as a manual to design concrete structures using BIM software. The example of BIM software that was used throughout the thesis is Graphisoft ArchiCAD and Tekla structures.

The design and construction is a big process and there is always the possibility of mistakes and errors. It involves the collaboration of different fields such as architecture, engineering (structural, mechanical, electrical, plumbing), construction management, contracting and business. So, one of the benefits of using BIM is to minimize such errors and collaborate among the team members effectively. During the design and construction phase, there is a task which is mutually dependent. That means that a delay in one task may cause a delay in another task and so forth in the entire project. The major cause of the delays in the field of Architectural, Engineering and Construction (AEC) industries is the time required for the collaboration of different fields. The advantage of the BIM is the fact that all the participating members will have a complete access to the information database which allows troubleshooting and conflict resolution that may occur during design. Therefore, BIM has the huge potential to optimize the quality of AEC industries. (4)
2 Building Information Modelling

BIM is a revolution in building design and construction technology. (5) BIM is considered as one of the most important factors for the development in Architecture, Engineering and Construction companies. BIM technology helps to construct an accurate digital virtual model of the building. The virtual model created with the help of a computer program contains exact geometry and relevant information to support the construction, fabrication and procurement activities required to construct the building. In practice, BIM is not only one model. Instead, there are various kind of models that are used in different ways in the same project. Nowadays, there are several definitions of BIM in which the basic meaning is the same with different nuances. According to the National BIM standard United States “Building information modelling (BIM) is a digital representation of physical and functional characteristics of a facility. A BIM is a shared knowledge resource to catalogue information about a facility forming a reliable basis for decisions during its life cycle; defined as existing from earliest conception to demolition.”

Building information model (BIM) is: (6)
- Well-Coordinated data.
- Geometric binding.
- Suitable for computer use.
- Capable of transferring to design and analysis software.

Building information model allows to update the numerical information on the projected or existing facility which can be used to
- Adopt the specific design solutions.
- Generate high-quality project documentation.
- Predict the performance of the building.
- Cost estimation of the building plans.
- Construction management of the building.
- Manufacturing and order of the equipment and materials.
- Manage and operate the building and facilities throughout the building lifecycle.
- Renovation and reconstruction of the building and
- Other building purposes. (6)

The typical workflow of the project with the use of Building Information Modelling (BIM) is shown in Figure 1.
BIM technology can help and develop the quality of business practice. Building information modelling is equally beneficial to all the parties for example the owner, architect, designer as well as AEC companies. BIM helps in different stages of the entire project. The key benefits of using Building information modelling can be categorized into four headings. They are as follows: (8)

i) Pre-construction Benefits to owner
   - BIM helps to visualize the design and analyze the feasibility of construction easily.
   - Enhancement of building performance and quality.
   - BIM helps in the decision making of the investment by comparing the scope, functionality and cost of the solutions.

ii) Design benefits
   - BIM helps to visualize the design at any phase of the design process and easily check against the design intent.
   - Provision of automatic correction when changes are made to design.
   - BIM helps to create accurate and consistent drawings at any design stage.
   - BIM supports data exchange with different design disciplines and makes the design process more efficient.
   - Cost estimation during the design phase.
   - Enhancement of energy performance and sustainability.
iii) Construction and Fabrication benefits
- BIM can easily synchronize the design and plan construction.
- Clash detection and omit the design errors before construction.
- BIM helps to solve the design or site problems quickly.
- The design model can be used for the fabrication of building components.

iv) Post construction Benefits
- BIM helps in better management of the building and operate facilities.
- BIM utilizes building project data during operation and facility management activities.

2.1 BIM for Architects
Building information modelling has become the choice of many architects. BIM helps architects throughout the building design lifecycle. (9) The building lifecycle from the point of view of BIM is shown in Figure 2. (6) BIM covers plenty of information related to Architectural design and modelling. BIM allows to effectively design from the conceptual phase to real construction with high efficiency and quality. There are different BIM tools available for architect. That is ArchiCAD, Autodesk Revit, Vector work, etc. BIM tools help architects to design the building and its elements using the 3D modelling process, prepare 2D drawings (Plan, Elevation, Sections) and access building information. In addition, BIM software also helps to analyze the data in BIM model for energy modelling and calculation, Construction Scheduling etc. (9)

Figure 2. Lifecycle of the building (6)
2.2 BIM for Structural Engineers

Structural engineers can take a huge advantage of the BIM technology. The building information modelling contains a lot of information related to structural modelling and analysis. BIM also covers the parameters including design codes (Euro code) and other standards. The research and development in the field of AEC industries have discovered practical building information modelling tools for Structural analysis, design and detailing. Building information modelling has helped the structural designers and engineers throughout the entire design process from the beginning of the design concept till construction. It is a fact that the BIM tools help in the construction of structure by applying three-dimensional (3D) modelling, which allows to rotate, layer or isolate the element and create plans, elevations and sections. Due to the linkage between the structural modelling software and analysis software, BIM helps to enhance the analysis and design (A&D) options of the structure. Taking time into consideration, BIM reduces the repetitive task such as labelling parts or modelling and designing similar components. (4)

Structural BIM is an important field for the designers to design steel, concrete, timber or masonry structures, which contain analysis and design (A&D) information. Structural BIM can also be used for the preparation of drawings, reports and structural documentation. Structural BIM is the BIM process, where multi-material structural information is created and refined to make the actual structure. The utilization of multi-material BIM concept allows the engineering practices to share the structural information among other companies and project members, providing true collaboration. (7)

3  BIM Software

3.1 ArchiCAD

3.1.1 History of ArchiCAD

The origin of Graphisoft ArchiCAD dates back to 1980. Due to the lack of internal concealed job opportunities, a group of few mathematical enterprises decided to start the first private companies in Hungary. At the same time, computer software development was the most popular entrepreneurial venture which reflects the high demand for creativity and innovation whereas the capital and infrastructure demand were relatively low. At the end of 1982, the Hungarian Ministry of Industry was looking for advanced computer aided design model for the Paks Nuclear Power Plant whose construction was delayed for three years. It was impossible to import an adequate computer program from the other western countries. That was the first blockage which the company man-
aged to turn to its benefit. The company realizes that the program blockage was the major reason for the turning point of the company. The company thought that it would be good to produce their own complete program since the proposals of their competitors would be expensive and with uncertain deadlines. The theme was successful and was worth the effort. Later, Graphisoft got the project with a huge profit in the company.

In the fall of 1983, the company displayed its 3D modelling system at a software exhibition in Munich, Germany. The development of professional personal computer had a significant effect on Graphisoft’s 3D modelling program. Graphisoft displayed its first 3D modelling design software on a personal computer in 1984 at Hannover Fair, Germany. Graphisoft was introduced to the Apple world which helped the company to network with different business partners from all over Europe. In the meantime, Graphisoft extended its market in Eastern Europe due to low overhead cost and moderate living standard. Only 50 to 100 software packages were sold with the income of few hundred thousand West German Marks. The new version of ArchiCAD was made better during this time. At the end of 1987, ArchiCAD was the first software to depend on the full capacity of new Apple product Macintosh II. About 1000 ArchiCAD software packages were sold in 1988 and 2000 packages in 1989 worldwide. By 1989, Graphisoft had become the market leader in Apple architectural design software in Western Europe with the net sales of 40%. (10) In 1993, Graphisoft released ArchiCAD for MS Windows. The product ArchiCAD for teamwork in 1997 was another milestone for the company.

3.1.2 General Information on ArchiCAD
ArchiCAD is an architectural BIM CAD software for apple Macintosh and MS windows developed by the Hungarian Company Graphisoft. ArchiCAD program is specially designed for architectural drawings of the building. ArchiCAD is the first CAD product on a personal computer which can create both 2D and 3D drawings. ArchiCAD helps the user to work with enhanced parametric objects, often called “Smart objects”. With the help of ArchiCAD, the users can create a virtual building with virtual structural components such as beams, columns, floors, walls, doors, windows, furniture etc. ArchiCAD program provides a wide variety of pre-designed objects which can be easily customized. ArchiCAD program also includes Geometric Description Language (GDL) to create a new component. (11)
ArchiCAD user can work on either 2D or 3D environment with the program. Plan, Elevations and Sections are produced from a virtual 3D model of the building and it can be constantly updated. Architectural drawings and details can be created with the help
of ArchiCAD. ArchiCAD can export and import different file format such DWG, DXF, IFC and SketchUp files. (11)

3.2 Tekla Software

3.2.1 History of Tekla

In the mid-1960s, computers and automatic data processing were well established in Finland. The companies that performed advanced computing and engineering had already adopted Automatic Data processing (ADP). Due to the huge computing work and limited amount of resources, the group of various engineering offices founded a joint software company named Teknillinen laskenta Oy (Technical Computing). The company was first registered in February 1966. In the same spring, the company’s name was changed to Tekla. The first office of Tekla software was set up in Helsinki, Finland. (12)

Tekla officially started its operation on July 1, 1966. The first program of Tekla was completed in 1967. By 1968, Tekla software development was focused on structural engineering, road building and earth moving. Tekla software was developed with the development of computers. The computerized way of calculation made work easier and faster. Time-saving calculations made the engineering work more efficient and effective. In 1975, Tekla business slowed down due to the economic crisis and recession. But Tekla program kept on continuing its software development. The development of Tekla software continued until the 1980s. At the time of recession, program such as plotter software and graphic printing were developed. Tekla acquired a central computer in 1979 where all designers and programmers could get their own alphanumeric terminals. In the early 1990s, the X-product family was established. Xsteel product completed in 1993 and became one of the most successful export products of Tekla. Tekla established its first subsidiary in Sweden in 1996. Since then Tekla has continued its investment in the international market. By 2008, various Tekla subsidiaries were founded in different parts of the world and Tekla partners grew gradually. In 2004, structural engineering software Tekla structure was launched. By 2008, International operations accounted for 80% of the net sales. Trimble Navigation Ltd acquired Tekla in 2011. In 2011, Tekla launched another program called Tekla Bimsight. Today, the success of Tekla has spread all over the world and it has customers in more than 100 countries globally. (12)

3.2.2 General Information on Tekla

Tekla is a large company, which has its partners around the world today. Tekla was first founded in 1966 and it has its headquarter is in Espoo, Finland. Tekla has been a
part of Trimble group since July 2011. Tekla provides its services in two business areas: Building and Construction and Energy and public Administration. (13) Tekla structure is 3D Modelling software that is widely used for concrete and steel detailing, pre-cast and in-situ concrete by structural designers, detailers and fabricators in the construction industry. Tekla software can use both application programming interface (API) and compatible IFC data formats. Tekla software contains API software link to different structural analysis programs like Autodesk Robot Structural Analysis, STAAD, SAP2000 and Microsoft excel. Tekla also has a link with an architectural software program like ArchiCAD, Revit, etc. Tekla structures can import/export or insert the reference models in different open formats including DXF, FEM, FABTROL XML, IFC, DGN, IFCXML, 3DD, etc. Tekla can easily open the files, which are in IFC data format. (4)

Tekla software also has another program called Tekla Bimsight for the free BIM viewer. Tekla Bimsight allows the user to view IFC files in 3D as well as the identification data related to elements or components in the model. The most important feature of Bimsight is to check the conflict and detect for clash or interference. Tekla Bimsight allows all the project members to get involved in the design process, contribute and interact with each other. Tekla also has construction management extension tools for its Tekla structure program which allows the user to use tools such as scheduler, material take-off generator, 4D visualization etc. Since, Tekla program is the database of element sizes, connections and materials, it can create the detail information of weight, quantity and fabrication of materials for scheduling various tasks. One of the most benefits of using Tekla in modelling is the ability to have multiple users working on one central file. (4)

4 Project Description

4.1 Building Information

The building is a two-storey single family house. The building consists of six rooms, one kitchen and one sauna. The frame of the building is made of reinforced concrete wall with insulation.
<table>
<thead>
<tr>
<th>Building Component</th>
<th>Picture or Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1) FOUNDATION</strong></td>
<td><img src="image1.png" alt="Foundation Diagram" /></td>
</tr>
</tbody>
</table>
| Reinforced concrete foundation  
(Size 600*200)  
Load bearing wall directly connected with foundation. |  |
| **2) WALLS**       | ![Walls Diagram](image2.png) |
| Exterior walls are load bearing walls.  
(Reinforced concrete + Insulation + Reinforced concrete)  
Interior walls are non-load bearing walls.  
See Appendix 2 for more details of the composition of walls. |  |
| **3) COLUMNS**     | ![Columns Diagram](image3.png) |
| Steel column in balcony.  
Reinforced Column for garage.  
Size 250*250 | Steel column profiles in balcony.  
Square hollow section 120*120*6 |
| **4) BEAMS**       | ![Beams Diagram](image4.png) |
| Steel beam in balcony.  
Reinforced beam for garage on south elevation  
Size 250*250 | Steel beam profile in the balcony.  
HEA 200 |
5) FLOORS
Ground floor
-Basement floor for the house.
-Basement floor for garage.
Intermediate floor
Concrete floor for balcony (Concrete slab + Hollow core slab)
See Appendix 2 for more details of the floor.

Thickness of basement floor
Garage 450mm
Building 600mm
Thickness of intermediate floor 275mm
(Concrete + Insulation + Hollow core slab)

6) ROOF
Timber roof
(Metal sheet + Ribs 32x100 + Block board 20mm + Truss rafter with blow wool insulation 500mm + SPU-AL 30mm + Lathing 48*48 K400 + Dry wall finish 13mm)
See appendix 2 for more details of the composition of roof.

The thickness of the roof is 591 mm.

7) FIRE SAFETY
EI 30 as shown in the first floor plan drawing in Appendix 1.

Concrete is used as a fireproof material on the west facade of the structure.

4.2 Building Plans and Drawings
Building plans and drawings were taken as a reference from one single family house project. The list of the documents for the project is listed below. See Appendix 1 for more details.

1. Asemapiiros (Site Plan)
2. Pohja (Floor Plan)
3. Leikkaus (Section)
4. Julkisivut (Elevation)
5. Katujulkisivu Ja Aitakuvat (Street Facade and Fence Pictures)
6. Kerrosalalaskelma (Gross Floor Area)
7. Hormi (Chimney)
5 Building Models

5.1 Architectural Modelling

5.1.1 ArchiCAD Basic

5.1.1.1 Project Settings and ArchiCAD Interface

Architectural Modelling for this project was done with the help of ArchiCAD version 19. To start work with a new project in ArchiCAD, a new project file was created. There is an option to choose a template or browse another template as shown in Figure 3. Then an untitled copy was created. At this point, design work in ArchiCAD can be proceeded and the name for an untitled project should be given before saving the project file. ArchiCAD template provides all project preference settings, placed element and tool default settings of the project. Most of the ArchiCAD users use the standard Graphisoft template which comes along with the version of ArchiCAD. It is not a bad idea to choose the default template at first, since it is a very clean and straightforward to develop the base in ArchiCAD. However, it is a good idea to browse one’s own template when we keep doing the same thing in our next project. It will help us to save our time because we don't have to repeat the same work again and again. The standard ArchiCAD 19 template was chosen for this project.

![Figure 3. The new project dialog box](image)

After this, the process was moved to the project preference settings. Project parameter settings can be edited by clicking on ‘Options>Project Preferences.’ Several project parameters such as working units, project location, reference level, etc. appear from the project preferences dialog box as shown in Figure 4.
Graphisoft ArchiCAD software is designed for an easy access of commands and views. ArchiCAD interface contains drawing area, info box, menu bar, navigator, menu bar toolbox, standard toolbar, status bar, zoom controls, etc. ArchiCAD interface is shown in Figure 5.

![ArchiCAD Interface](image)

Figure 4. Project preference settings

Figure 5. ArchiCAD Interface
5.1.1.2 Setting with Grids and Stories

As there were no any grid lines on the plan provided, the first step was to figure out the grid which would provide guidelines for the project and make drawing easier. The grid lines were placed on the boundaries of the exterior wall. The purpose of making the gridline was to make the plan more logical and visible. The horizontal grids were defined by the letters whereas the vertical grids were defined by the numbers as shown in Figure 6. With the help of ArchiCAD, it is possible to define all the grid lines at one time. It also allows the user to draw the grids separately if the shape of the grid needs to be modified, for example a curved gridline. In this case, all the drawings were straight, so it was possible to place the grid with the help of the grid system.

![Figure 6. Grid position in ArchiCAD](image1)

![Figure 7. Story settings in ArchiCAD](image2)

After placing the grids, the stories were assigned for the project. The height of the floor was 3 meters on the first floor and 3.4 meters on the second floor. The depth of the foundation was 1200 mm from the ground level. Stories can be created by clicking on ‘Insert above’ or ‘Insert below’ option from the story setting dialog box as shown in Figure 7.
5.1.1.3 Importing Drawings in ArchiCAD

Reference drawings can be imported in ArchiCAD. To make the drawing work faster and easier, plan drawings were imported in ArchiCAD program. The reference plan drawings were used as an underlay so that it was not necessary to see the picture of the plan frequently when drawing the model. Importing of plans can be done by clicking on ‘File>External content>Place external drawing’ as shown in Figure 8.

![Figure 8. Importing plan drawings in ArchiCAD](image)

Similarly, it is also possible to import section and other drawings as reference drawings in ArchiCAD program.
5.1.1.4 Layer Settings in ArchiCAD

A set of layers are already defined by default in ArchiCAD. However, it is possible to give a name and make one’s own layer in ArchiCAD. For each layer, the settings such as lock or unlock, show or hide, 3D view mode and layer intersection group can be defined. Working on the layer is very important during the modelling process in ArchiCAD since it helps to separate the elements from one another. Layer settings dialog box can be opened by clicking on ‘Document>Layers>Layer Settings’ from the menu bar. The new layer was created by selecting ‘New’ option and the name of layer was given as shown in Figure 9 and then Clicked on ‘ok>update>ok’.

![Layer Settings in ArchiCAD](image)

Figure 9. Making own layer in ArchiCAD

5.1.1.5 Settings of the Building Materials

ArchiCAD has a huge amount of building materials in its library but these materials may not be sufficient to work in every project. Therefore, the materials need to be modified. ArchiCAD has the feature to edit or make new material. It is possible to create the new material from a full blank dialog box or from already existing building materials. The building material dialog box can be opened by clicking ‘Options>Element attributes>Building materials’ from the menu bar. At the bottom of the Building material dialogue box, a new building material can be created as shown in Figure 10.
Making of new material can also be done with the help of Composite Structures. Composite structures are used when there is a need of more than one layer. In Finland, most of the building envelope structures like the wall, floor, roof, etc. consist of more than one layer. Therefore, the composite structure must be created for such structures. Drawing of each different layer of a wall separately means a lot of work and waste of time for the user. Therefore, ArchiCAD has the feature to create a composite structure where all the required materials are combined to create a single wall. To explain more about how to create a composite structure, one composite structure for the exterior wall of the project is created as an example. The composite material dialog box can be opened by clicking on ‘Options>Element attributes>Composite structure’ from the menu bar. To make the composite structure, ‘New’ option was clicked from the composite structure dialog box and the name of the structure was given as shown in Figure 11.

Figure 10. Building material settings dialog box
The Outer walls are load bearing structures and have a total thickness of 400 mm. The outer wall consists of three different layers as mentioned in the reference drawings. The wall consists of reinforced concrete material on both sides having a thickness of 115 mm and insulation of 170 mm in the middle. Therefore, two more layers were added by clicking on ‘Insert skin’ option as shown in Figure 12. After that, the material was chosen from the available building materials in ArchiCAD. After adding those materials, the thickness of each skin was defined. Similarly, with the same process, a composite structure for floors, roofs, etc. was created. The composition of different building envelope structure for walls, floors, roofs, etc. is shown in Appendix 2.
5.1.2 Creating Architectural Model in ArchiCAD

ArchiCAD modelling was a long process since it took time for the author to learn the program and get information from the drawings and detailing of the project. Modelling was done with the help of the drawings presented in Appendix 1. Different building components such as foundation, walls, slabs, beams, columns, roofs, etc. were created to complete a house model in ArchiCAD.

5.1.2.1 Foundation

The first step of making the foundation was to make a story for the foundation. The foundation was created by placing the wall of thickness 600 mm on the plan which is directly connected with footings wall as shown in Figure 13.

![Figure 13. Foundation plan in ArchiCAD](image)

5.1.2.2 Walls

To start creating walls, ‘wall’ icon was selected from the toolbox. A wall default settings dialog box appears from where the parameters such as the width and height of the wall, override surfaces, etc. can be defined. On the right side of the settings dialog box, the structure of the wall can be defined as shown in Figure 16. The first option to define the wall is ‘basic wall’ which consists of only one layer of material. The next option is ‘composite wall’ which is composed of more than one layer of material. By clicking on the composite wall, it is possible to choose one of the earlier created composite wall structures from the list. The reference line of the element can also be defined in the wall settings dialog box. In ArchiCAD, there are six different ref-
ference lines for the wall element as shown in Figure 15. They are outside, inside, center, core center, core outside and core inside. After setting the reference line, ‘Ok’ option was clicked on the dialog box and the walls were created. It is also possible to select several settings directly from info box tool as shown in Figure 14.

Figure 14. Wall Settings on Info box

Figure 15. Reference Lines for wall

Figure 16. Wall default settings

5.1.2.3 Slabs
Slabs can be created from the ‘slab’ icon in the tool box. After clicking on the slab option, Slab default setting dialog box pop-ups where the user can define the different parameters such as the thickness of the slab, override surfaces, etc. It is also possible to define the offset of the slab corresponding to the home story. The home story of the slab can also be defined in this setting. There is also another option to locate the home story of the slab. This option allows the user to define the distance relative to project zero, sea level, current story or other reference levels. On the right side of the dialog box, a slab structure can be defined. The first option to define the slab is ‘basic slab’
which consists of only one layer or material. The next option is ‘composite slab’ which consists of more than one layer. In this case, the slab is composed of more than one layer of a different thickness. So, the new composite slab structure was created. In the info box, there are three different geometry methods for creating the shape of the slab. They are polygonal, rectangle and rotated rectangle. Polygonal methods were used to create a slab for this project. It is also possible to choose the different settings of slab directly from info box tool as shown in Figure 17. The reference plane (top, bottom, core top, core bottom) for the slab can also be defined from the slab setting box. The default setting box for the slab is shown in Figure 18. The new composite slab was selected to create the slab in ArchiCAD model as shown in Figure 19.

![Slab settings on info box](image)

**Figure 17. Slab settings on info box**

![Slab default settings](image)

**Figure 18. Slab default settings**

![Slab on the basement floor in ArchiCAD](image)

**Figure 19. Slab on the basement floor in ArchiCAD**

### 5.1.2.4 Beams and Columns

Due to the load bearing nature of the walls in the structure, no other beams and columns were used in the design of house building. However, steel columns and beams were used for the support of a balcony. There are altogether three steel columns and three steel beams for the support of the balcony in the west facade of the structure. Similarly, there are also two reinforced columns in the west facade and one reinforced
column and two reinforced beams in the south facade in the garage. In ArchiCAD, beams were created by clicking on ‘beam’ icon in the toolbox. The beam default settings dialog box appears where the user can define the different parameters such as the size of the beam, height of the beam, building materials, override surfaces, etc. The home story for the beam is created by default. The home story allows the user to select one of the stories that were created before. The reference axis setting was also defined from the beam settings dialog box as shown in Figure 20. The reference axis is located in the middle of the beam by default.

Similarly, columns were created by clicking on ‘column’ icon in the tool box. Column settings dialog box allows the user to define the size and shape of the column, building materials, override surfaces, etc. as shown in Figure 21. The settings dialog box also allows the user to define the home story and link between the bottom and top of the column to the stories that were already created. It is also possible to choose the column to be vertical or slanted from the setting dialog box. There is another setting known as an anchor point of the column in the setting dialog box which defines the anchor point of the column.
5.1.2.5 Roofs

‘Roof’ icon was selected from the toolbox to construct a roof in ArchiCAD model. In the roof settings dialog box, different parameters such as the structure of the roof, building materials, home story for the roof can be defined as shown in Figure 22. The Settings dialog box also has features to define the slope of the roof. The slope of the roof can be defined in degrees or percentage as shown in the options. In this case, 20% slope was defined for both roofs in the first and second floor. Likewise, the default setting box also allows the user to assign an angle for the roof edge. In this case, a vertical angle for the roof’s edge was set to make the roof. The placement of roof in ArchiCAD 3D model is shown in Figure 23.

5.1.2.6 Staircase

Stairs were created by selecting ‘stair’ icon from the toolbox. The staircase on the default was not suitable to make the stairs in this project. Therefore, new Stair was created by clicking on `create stair´ option from stair default setting box as shown in Figure 24. The type of stairs was selected from the stair type selection list. Different parameters such as geometry settings, structure, tread, railing settings were defined from the new created stair. It is possible to adjust the total rise height, flight width, full length of stairs, flight settings from the geometry settings as shown in Figure 25. The settings also allow the user to change the structure of stairs from the structure option.
The thickness of tread, nosing size on the front, riser thickness, etc. can be defined from the tread settings option. The Section of the staircase is shown in Figure 26.

![Staircase section model in ArchiCAD](image)

**Figure 24.** Stair default settings

**Figure 25.** Stair geometry settings

**Figure 26.** Staircase section model in ArchiCAD

5.1.2.7 Doors and Windows

Doors and windows were added by selecting the ‘door’ icon and ‘window’ icon from the toolbox. Several types of door and window were browsed through the library of ArchiCAD 19. A Hinge door and hinge window 19 were selected from the door list of ArchiCAD library. From the default settings dialog box, different parameter such as width and height of the door and window were adjusted as shown in Figure 27. The reference point for the door was taken from the bottom of the story with zero sill height.
whereas the reference point for the window was taken from the top of the story in this case.

Figure 27. Door and window default settings

5.1.2.8 Other Objects
Objects such as kitchen accessories, ladder, fireplace, bathroom sink, tap, WC commode, etc. can be found in object libraries. Some objects were not available in ArchiCAD library. Therefore, those objects were downloaded from M.A.D website. The basic library PK19 whole package was downloaded and added to object library in ArchiCAD. Objects were created by clicking on ‘object’ icon from the tool box. Different parameters such as home story, width and height of the object were adjusted from the object selection settings dialog box as shown in Figure 28.

Figure 28. Object selection settings dialog box.
5.1.3 Creating Drawings in ArchiCAD

Architectural drawings can be created in ArchiCAD which includes floor plan, elevation and section drawings. Drawings can be created in ArchiCAD from navigator layout book. One of the example of creating the drawings have been explained in this thesis. To create a drawing in ArchiCAD, new layout was created by clicking on ‘Documents>Layout>New layout book’. The name of the layout was assigned as ‘Elevation drawing’ and the size was defined as ‘A4’ for the drawings. After that, each elevation was placed inside the layout book and the elevation drawings were created as shown in Figure 29. Similarly, it is also possible to create the floor plan and section drawings with the same process.

Figure 29. Elevation drawings in ArchiCAD
5.1.4 Linking ArchiCAD Model with Tekla Structures
ArchiCAD model can be linked with Tekla structures with IFC format. ArchiCAD model can be saved in IFC file by clicking on ‘File>Save as>Save’ as shown in Figure 30.

![Figure 30. Saving IFC file in ArchiCAD program](image)

5.2 Structural Modelling
Modelling of the structure was done with the use of Tekla Structures 2016. Modelling in Tekla was done with the help of reference IFC file which was created from ArchiCAD program. Structural components such as foundation, load bearing walls, slabs, beams, columns, etc. were created to complete the structural model in Tekla. Non-load bearing elements were not considered as structure during the modelling process.

5.2.1 Tekla Basic
5.2.1.1 Tekla Set up & Interface
Before starting to work with Tekla structures, the Tekla structures set up was done. Different settings such as environment, role and configuration were defined for the project as shown in Figure 31. Tekla structure interface contains the database for both steel as well as concrete structures. As the case was a pre-fabricated concrete structure, concrete structure (FIN Betonirakennesuunnitteluja) configuration was used. Finland environment was selected for this project. The license configuration is an educational version.
Tekla interface is designed for an easy and quick access to commands and views. Tekla interface contains grid, working area box, status bar, file menu, selection switches, snap switches, side pane, quick launch box, etc. as shown in Figure 32.

Figure 31. Tekla structures set up dialog box

Figure 32. Tekla interface with reference IFC model
5.2.1.2 Setting with Grids in X, Y and Z Co-ordinates

Grid was selected by clicking the grid on working box. There is also another possibility to make the grid in Tekla by selecting the grid from the quick command box. X, Y and Z coordinates were adjusted in grid settings dialog box as shown in Figure 33. The vertical label was represented by numbers whereas the horizontal label was represented by alphabets.

![Figure 33. Grid Settings in Tekla](image)

5.2.1.3 Importing IFC Model in Tekla

Importing of IFC model in Tekla was done by clicking on reference model from the side pane. The reference model was imported by choosing the IFC model from the folder as shown in Figure 34. IFC model was imported in the origin because the original location of the project was also in origin in ArchiCAD program. It is also possible to locate the reference model in the different coordinate system.

![Figure 34. Importing IFC in Tekla](image)
5.2.2 Creating Structural Model in Tekla Structures

5.2.2.1 Foundation

The foundation was created by clicking on footing option from the concrete command box. A strip footing was selected for this project. The footing wall was created by selecting a nonbearing plinth from the application and components box as shown in Figure 35. The height of the footing wall was defined 1000 mm below the ground level. The thickness for both the exterior and interior reinforced concrete wall was given 115 mm and the thickness of the insulation layer were given 170 mm. The total height of 300 mm of the inner wall was reduced from the top level to support the insulated concrete slab. The concrete grade C25/30 was defined for both reinforced concrete walls. The EPS material was selected for the insulation.

![Figure 35. Non-bearing plinth dialog box](image)

5.2.2.2 Walls

Bearing sandwich (1) was selected from application and components box to create load bearing walls. The creation of wall was easier due to the reference IFC model. Different parameters such as thickness and height of the wall, materials, etc. were defined from the bearing sandwich dialog box. The thickness for both exterior and interior reinforced concrete wall was defined 115 mm whereas 170 mm of thickness was de-
fined for the insulation layer as shown in Figure 36. Similarly, 175 mm of total height was reduced from the top of the inner wall to support the hollow core slab in the structure.

![Figure 36. Bearing sandwich (1) dialog box](image)

5.2.2.3 Door and Window Openings

Wall and door openings in precast wall elements were added on the sandwich wall by selecting hole generation (32) component. In the hole generation dialog box, the first option to create the opening is to define the height and the width of the openings as shown in Figure 37. The next option is to define the sill height and the location of the openings from the corner of the respective wall. The location of the opening from the corner was measured with the help of reference IFC model in Tekla structures.
Figure 37. Hole generation dialog box and window openings in Tekla 3D model

5.2.2.4 Slabs

Slabs were created by using a floor layout tool from application and components box. For the ground floor, three layers were added by clicking on plus icon from the layout dialog box as shown in Figure 38. It is also possible to delete the layer by clicking a cross icon and arrange the layer by a move up and move down icon. The layer name, layer type, thickness and material of each layer was defined from the layer option.

Figure 38. Ground floor layout dialog box
Similarly, three layers were defined for the intermediate floor in the layout dialog box as shown in Figure 39. The composition of the intermediate floor in Tekla is presented in Appendix 3.

![Intermediate floor layout dialog box](image)

**Figure 39. Intermediate floor layout dialog box**

5.2.2.5 Beams and Columns
Concrete beams were created by selecting concrete beam 🏗️ icon from the concrete command box and steel beams were created by selecting steel beam 🏗️ icon from the steel command box. In properties dialog box, different attributes such as profile, material, etc. were defined as shown in Figures 40 and 41 for concrete and steel beam respectively.

![Concrete beam properties box](image)

**Figure 40. Concrete beam properties box**

![Steel beam properties box](image)

**Figure 41. Steel beam properties box**
Similarly, concrete columns were created by selecting concrete column icon from the concrete command box and steel columns were created by selecting steel column icon from the steel command box. In properties dialog box, different attributes such as profile, material were defined as shown in Figures 42 and 43 for concrete and steel beam respectively.

Figure 42. Concrete column properties box        Figure 43. Steel Column properties box

5.3 Reinforcement Design

5.3.1 Beam and Column Reinforcement
Beam reinforcement was added from Beam reinforcement (63) component. Concrete cover, stirrups spacing, thickness of stirrups, size of main bar, size of stirrups, number of tension bar and top bar were defined in the beam reinforcement dialog box. Similarly, Column reinforcement was added from rectangular column reinforcement (83) component. Several parameters such as the thickness of stirrups and main bars, concrete cover, spacing of stirrups were defined in rectangular column reinforcement dialog box. Detail design of beam and column reinforcement in Tekla is presented in Appendix 3.
5.3.2 Wall Reinforcement

Wall panel reinforcement is useful for detailing pre-fabricated wall elements in Tekla structures. The wall panel reinforcement includes the reinforcement on the edges, around the openings, mesh for the whole wall panel and additional bars for wall shoe connection. The wall panel reinforcement was selected from application and components box to make reinforcement for both an outer as well as an inner wall of exterior load bearing wall. The detail of reinforcement mesh for inner wall and the outer wall of exterior wall are T8 @ 150 c/c and T5 @ 150 c/c respectively. Several parameters such as reinforcement, openings, diagonals, column, beam, etc. were adjusted from the wall panel reinforcement dialog box as shown in Figure 44. Each parameter of wall panel reinforcement settings is presented in Appendix 3.

![Wall panel reinforcement dialog box and wall reinforcement in Tekla model](image)

**Figure 44.** Wall panel reinforcement dialog box and wall reinforcement in Tekla model

5.3.3 Slab Reinforcement

Reinforcement in slab was added by using a slab bar (18) from the application and components box as shown in Figure 45. The reinforcement mesh with the bar of thickness of 5 mm at the distance of 150 centre to centre was created. Different settings for top bar, bottom bar were adjusted from the slab reinforcement dialog box as presented in Appendix 3.
5.3.4 Footing Reinforcement

A strip footing was used for the foundation of the structure. Therefore, Strip footing reinforcement (75) was used for reinforcing the foundation as shown in Figure 46. Several parameters of main bars and stirrups was adjusted as presented in Appendix 3.
5.4 Connection Design

5.4.1 Wall Connection

Different types of sandwich wall element connections were used to connect the walls. The list of wall connection component can be found in application and components box as shown in Figure 47. The type of wall connection which was used for modelling this project are PC_EW_EW_GR_04, PC_EW_EW_GR_07, PC_EW_EW_GR_10 and PC_EW_EW_GR_13.

The selection of wall connection depends upon the positioning of the wall. To explain more about how to create the wall connection, one example of connection is described in this section. First of all, to get those connections, Finland environment was downloaded from Tekla website and installed in the computer. PC_EW_EW_GR_13 was selected from the application and components box. The main part of the wall element was selected in order of 1, 2, 3, 4, 5 and 6 on the layer of the wall as shown in Figure 48. The middle button of the mouse was then clicked to connect the walls. Similarly, other wall connections were also added to connect the wall with the same process.

---

Figure 47. Wall Connection list

Figure 48. Wall connection dialog box
5.4.2 Beam and Column Connection

For concrete beams and columns, the connection was added with a corbel connection. The corbel connection (14) was used as shown in Figure 49.

For the steel beams and columns, the connection was done with the weld. HEA 200 steel beam was connected to a square hollow section with the help of welding. Welding was done by adding a plate on the square hollow section. Weld was created on Tekla by choosing the weld option from the steel command box and created with a polygon weld around the square hollow section.
5.4.3 Footing and Column Connection

Footing and columns were connected by using a base plate (1042) component as shown in Figure 50. Several parameters such as endplate size, plate thickness, bolt size, anchor rod, etc. were defined from the base plate setting box. A detail design of the base plate in Tekla is presented in Appendix 3.

![Base plate to connect steel column and concrete foundation in Tekla](image)

Figure 50. Base plate to connect steel column and concrete foundation in Tekla

5.5 Creating Drawings in Tekla Structures

Tekla Structures prepares both structural and workshop drawings which are used for element manufacture, steel fabrication and construction work. Tekla drawings include plenty of features that help us to create and manage the drawings. The drawings contain three main types of element. They are drawing layout, drawing views and drawing objects. Different types of drawings such as General arrangement drawings, cast unit drawings, element drawings, single part drawings, assembly drawings etc. can be created in Tekla. The cast unit drawings and element drawings are made for concrete structure where as single part drawing, assembly drawings are made for steel structure. One example of creating the cast unit drawings in Tekla is explained in this thesis. To create drawings, cast unit drawings of the structural column is presented in thesis. First of all, column was selected from Tekla model. And then drawing was created by clicking on ‘Drawings & reports>Create drawings>Cast unit drawing’ from the menu bar. Similarly, cast unit drawings for walls, slabs, beams, foundations etc. can be created. The cast unit drawing of reinforced concrete column is shown in Figure 51.
Figure 51. Cast unit drawing of column in Tekla
6 Conclusion

ArchiCAD, one of the most popular architectural modelling software in Finland has a variety of tools and elements for modelling which makes this program more efficient than AutoCAD. ArchiCAD provides the user to work with its tools and GDL object which helps to make the architectural model in the program. On the other hand, Tekla is one of the most popular structural modelling software in Finland. Tekla also has a huge variety of tools and components for structural modelling. It creates the connection between the elements which make Tekla program more applicable than any other software. Besides this, there are still several benefits of using the software. One of the biggest benefits of using BIM software is to create a BIM model in the program. BIM model is the shared information model which contains all the information and can link with another program by compatible file format. In this thesis, the architectural model was created in ArchiCAD and then the created ArchiCAD model was linked with Tekla software by IFC. Another benefit of using BIM software is to have multiple users working on one central file which helps to minimise time and errors. The utilization of BIM concept allows the engineering practices to share the project information among other companies and project members, providing true collaboration.

Architectural Modelling is a basic part of design and it involves the generation of 3D model, plan, elevation and section drawings. Architectural modelling can be used both for visualization and construction purposes. Architectural modelling is the initial design or modelling phase for any building projects. The architectural model should be taken into account for structural stability and analysis. And the structural modelling can be performed as per the design and calculations.

Structural modelling is a part of structural design. Therefore, structural modelling should be considered the significant factor during the design phase since it is used for the preparation of drawings, reports and structural documentation. In some cases, there were no any exact structural calculations, so the reinforcement design for columns, beams and pad footings were done without any calculated value.

Being able to spend so much time with ArchiCAD and Tekla Structures, resulted in gaining a lot of experience in 3D-modelling of structures. Further research can be conducted in the structural analysis of a single family house.
7 References


Appendix 1
Reference drawings
Site Plan

First floor
Appendix 1

3 (5)

Elevation Drawings

ITAÄN

LÄNTEEN

ETELÄÄN (KRUVINKARELLE)

POHJOSEEN
Gross area for each floor

1. krs

2. krs
Appendix 2

ArchiCAD

Composition of load bearing exterior wall.

Composition of non-load bearing interior wall for first floor.
Composition of interior non-load bearing wall for intermediate floor.

Composition of Sauna insulated wall.
Composition of half insulated wall (Gable wall) for the roof space

Composition of Roof
Ground Floor; Composition of basement floor for house.

![Composite Structures](image1)

Ground Floor; Composition of basement floor for car garage.

![Composite Structures](image2)
Composition of intermediate floor.
Appendix 3
Tekla structure
Composition of intermediate floor in Tekla
Design of beam reinforcement in Tekla
Design of column reinforcement in Tekla
Design of reinforcement bearing sandwich wall in Tekla
Design of Strip footing reinforcement in Tekla
Design of slab reinforcement in Tekla